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The U.S. Environmental Protection Agency (EPA) recognizes the overall 
environmental benefit of siting renewable energy projects on contaminated 
lands, landfills, and mine sites. To facilitate the implementation of these 
reuse projects, EPA’s RE-Powering America’s Land Initiative developed site 
screening tools in collaboration with the U.S. Department of Energy’s (DOE) 
National Renewable Energy Laboratory (NREL). 
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Introduction to RE-Powering Site Screening 
The RE-Powering Mapper (KMZ) and the RE-Powering Screening Dataset 
spreadsheet (XLS) serve as preliminary screening tools for renewable 
energy potential at contaminated lands, landfills, and mines sites nationwide. 
These tools provide high-level screening results for four renewable energy 
technologies: solar, wind, biomass, and geothermal. Sites are vetted based 
on four primary characteristics:  

• Renewable energy resource, 
• Acreage, 
• Distance to transmission lines, and 
• Distance to transportation infrastructure.1 

This reference guide provides users with tips for using the RE-Powering 
Screening Dataset spreadsheet, which contains detailed site information on 
over 60,000 contaminated lands, landfills, and mine sites. Local 
communities, potential developers, regulators, and other interested 
stakeholders are encouraged to use these tools to assess potential for future 
renewable energy projects on contaminated lands, landfills, and mine sites. 

Examples of how this data may be helpful for RE-Powering stakeholders include, but are not limited to: 

• Community stakeholders: Create a report to show all contaminated sites and/or landfills with renewable 
energy potential within their city or county. 

• City planners: Develop a priority list of landfills with potential for solar energy development, including 
those with landfill gas potential or existing infrastructure. 

• Renewable energy developers: Identify sites in target markets that meet requirements specific to their 
product offering. 

• Remediation professionals: Consider potential reuse opportunities with renewable energy when 
evaluating and selecting remedies. 

                                                

1 For additional information on the screening process or data contained in the spreadsheet, please refer to the “Data Documentation for Mapping and 
Screening Criteria for Renewable Energy Generation Potential on EPA and State Tracked Sites” 

RE-Powering America’s 
Land Initiative 

Through the RE-Powering America’s 
Land Initiative, the EPA promotes the 
reuse of potentially contaminated 
lands, landfills, and mine sites for 
renewable energy through a 
combination of tailored redevelopment 
tools, as well as site-specific technical 
support. 

The Initiative aims to revitalize 
degraded land by promoting 
renewable energy as a productive end 
use, when aligned with the community 
vision for the site. 

Advantages of Reuse 
Potentially contaminated lands, 
landfills, and mine sites offer 
developers a unique value proposition 
for renewable energy deployment by:  

• Leveraging existing infrastructure 
• Reducing project cycle times 

through streamlined permitting and 
zoning 

• Improving project economics with 
reduced land costs and tax 
incentives 

• Building a sustainable land 
development strategy by using 
contaminated lands 

• Gaining community support 
• Protecting open space 
 

For more information, go to: 
www.epa.gov/renewableenergyland/ 

http://www.epa.gov/renewableenergyland/docs/repowering_mapper_datadocumentation.pdf
http://www.epa.gov/renewableenergyland/docs/repowering_mapper_datadocumentation.pdf
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RE-Powering Screening Dataset: Spreadsheet Contents & Organization 
The RE-Powering Screening Dataset spreadsheet provides a more detailed view of site characteristics and 
renewable energy resources on over 60,000 EPA- and state-tracked sites. Tracked sites include: sites where 
EPA or states are involved with cleanup or reclamation; sites that have received grants from EPA or states; or 
sites that participate in EPA or state programs.  

This information is organized into fields among five major categories: 

• Site identification: Provides site name, location, acreage, and links to remediation programs. 
• Policy: Indicates if site is located in a state with a Renewable Energy Portfolio Standard (RPS) or within 

a Renewable Energy Zone (REZ).  
• Renewable Energy Potential: Indicates positive screening results for each renewable energy 

technology, from small- to utility-scale development potential. 
• Infrastructure: Provides data on proximity to critical infrastructure and identifies nearby urban areas. 
• Renewable Energy Resource Data: Provides quantitative resource data for solar, wind, biomass, landfill 

gas, and geothermal technologies. 
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The RE-Powering Screening Dataset spreadsheet consists of three worksheets, which appear as three 
different tabs in the lower left hand corner of your screen.   

 
• Read Me: Provides name and detailed descriptions of all data attributes. 
• Screening Criteria: Provides an overview of the estimated project capacity and screening criteria used. 
• Data: Includes all the information about 60,000-plus sites currently tracked by RE-Powering and states. 

The information is sorted by State (ST), City, and then Site Name.  

This information can be used a variety of ways: to identify sites with renewable energy potential or, conversely, 
to identify renewable energy opportunities for a given site. 

To facilitate use of the spreadsheet, several exercises are provided to enable users to create custom lists and 
summary reports by using the “Filter” and “PivotTable” functions available in MS Excel.  

Identifying sites with Data Filters 
The RE-Powering Screening Dataset spreadsheet is provided in MS Excel format. This software includes a 
feature that allows users to filter large datasets for particular attributes, e.g., sites located in the State of 
Delaware or sites within one mile of transmission lines. This feature can be used to filter based on a single 
attribute or multiple attributes in combination. These instructions were written for MS Office Excel 2007. 

The instructions below will walk you through turning on the “Filter” function and provide brief exercises to 
familiarize you with its use. 
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How to turn on the Filter function 
1. Select Row 1 in the spreadsheet by clicking on the “1” in the row. The complete row will be highlighted. 

 
 

2. On the tool ribbon, go to the “Data” tab, in Sort & Filter group, click “Filter.” 

 
 

3. Once enabled, an arrow  will appear in Row 1 for each column. 
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Exercise 1: How to filter for sites in your State 
1. Locate the State column labeled “ST.”  
2. Click on the arrow  to display the complete list of states and territories included in the dataset.  

 
3. Uncheck the “(Select All)” default option. Scroll down and select the state(s) of interest. For this 

example, the filter is applied to identify sites in Colorado (CO). 
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4. Click “OK” to apply the filter. You will now see only sites located in the State of Colorado. In the current 
dataset, there are 582 Colorado sites. 

 
Note: Once the filter is applied, the arrow  will change to a new icon with a filter and arrow  to 
indicate that a filter has been applied to that particular column. Highlighting in the filtered column is 
shown for demonstration purposes only. 

Exercise 2: How to apply multiple filters 
Now that you have successfully applied a filter to show sites in a single state, add three more filters to the 
dataset to identify sites with the following characteristics: 

• Located in the State of Colorado (CO) (Completed in Exercise 1) 
• Landfills tracked through EPA’s Landfill Methane Outreach Program (LMOP) 
• Positive screening result for “Solar PV: Large-scale”  
• Landfill status of “Closed” 

Apply each filter as follows: 

1. Locate the EPA/State Program column labeled, “Program” (Column B). 
2. Click on the arrow  to display the dropdown list. Select “Landfill Methane Outreach Program” and 

click “OK.” 

 
Note: This dropdown list reflects only those options available after the application of the first filter in 
Exercise 1. In this example, it will show only EPA programs associated with sites in Colorado, e.g., 
AML, Brownfield, LMOP, RCRA, and Superfund.  
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3. Repeat the filtering process using the “Solar PV: Large-scale” column and by selecting “X” for positive 
screening results. 

 
 

4. Repeat the filtering process for Landfill Status by selecting “Closed.” 
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After applying these four filters, you should have narrowed the dataset from over 60,000 sites to four: 

 
In general, most filter-based searches will yield a greater number of sites. This exercise demonstrates the 
ability to use this large dataset to target a set of sites, which could be used for planning or development 
purposes.  

Exercise 3: How to remove filters 
If you would like to change your filter-based search, you may clear the filters two ways.  

To remove an individual filter 

1. Click on the filter icon  in the lower right of the desired column header.  

 
2. Click “Clear Filter from “<attribute name>,” e.g., “Program” in this example. Once the filter has been 

removed, the arrow  will reappear in that single column.  
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To remove all filters 
1. On the tool ribbon, go to the “Data” tab, in Sort & Filter group, click “Clear.”  

 
2. Once the filters have been removed, the arrow  will reappear in all affected columns. The complete 

dataset will once again be visible. 

Creating Summary Reports with PivotTables 
Pivot tables are a convenient way to view and summarize large datasets. The RE-Powering Screening Dataset 
spreadsheet offers many opportunities for data mining the renewable energy potential on contaminated lands, 
landfills, and mine sites.  

The instructions below will walk you through creating a pivot table and provide brief exercises to familiarize you 
with their use. 

How to create a PivotTable 
1. On the “Data” worksheet, select the complete dataset.  

TIP: To select the complete dataset, click in Cell A1. Then, holding down the SHIFT and CTRL keys, hit 
the right arrow, followed by the down arrow. This will select the full data set. In this case, Cells A1 to 
CM66306 will be selected. 

On the tool ribbon, go to the “Insert” tab. In the Tables group, click “Pivot Table.” 
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2. To create the PivotTable in a new worksheet, click “OK.” 

 
3. On a new worksheet, you will now see an empty PivotTable and a PivotTable Field List pop-up window.  

 
TIP: The PivotTable Field List is a pop-up window that is only available when the cell or range of cells selected 
is within the bounds of the PivotTable. If you click outside of the PivotTable, the Field List pop-up will 
disappear. If you close the Field List and wish to reopen it, click in the PivotTable in order to show the 
PivotTable Tools in the ribbon. On the “Options” tab, in the “Show/Hide” group, click “Field List.”  
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Exercise 4: How to create a summary table for Utility-Scale Solar Potential by EPA Region  
1. In the PivotTable Field List, click on “EPA Region” and drag it to “Row Labels” in the bottom left corner. 

Once complete, the PivotTable will list all ten EPA regions in the column to the left. 

 
2. For this example, scroll down the field list and select “Solar PV: Utility Scale.” Drag and drop it into 

“Values” in the bottom right corner of the PivotTable Field List.  
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Once complete, the PivotTable will show a second column labeled “Count of Solar PV: Utility scale.” 
This value represents the number of sites in each region with Utility-Scale Solar PV potential. 

 
Exercise 5: How to add additional attributes to the PivotTable 
While it is useful to know the number of sites with utility-scale solar PV potential, you may also want to see the 
estimated solar capacity or how much solar could be installed on these sites.  

1. Because you want to show values only associated with sites that screened positively for “Solar PV: 
Utility scale,” you will need to add this attribute as a filter. Scroll down the field list and select “Solar PV: 
Utility scale”. Drag and drop it into “Report Filter” in the top left corner of the PivotTable Field List.  
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Once complete, a new row will now show above the PivotTable, indicating a filter for “Solar PV: Utility 
scale” is available, but not yet applied as indicated by the “(All)” designation and the arrow  
dropdown. 

 
To apply the filter, click on the arrow  and select “X”. Click Ok to apply the filter.  

 
Once the filter is applied, the PivotTable will no longer show EPA Regions where sites did not meet the 
screening criteria for Utility-Scale Solar PV. You will now see that Regions 1, 3 and, 5 are no longer 
listed. 

.   
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2. Scroll down the field list and select “Estimated Solar PV Capacity Potential.” Drag and drop it into 
“Value” in the bottom right corner of the PivotTable Field List below “Count of Solar PV: Utility scale.” 

 
Once complete, a new column will now show in the PivotTable, titled “Count of Estimated Solar PV 
Capacity Potential (MW).” Because it is displaying the count, the values will match those shown in 
“Count of Solar PV: Utility scale.” 

 
  



RE-Powering America’s Land:  
A Primer for Using RE-Powering Data to Screen Sites for Renewable Potential 

 15 August 2013 

3. To display the cumulative “Estimated Solar PV Capacity Potential (MW),” the PivotTable Value needs 
to be changed from “Count” to “Sum.” Begin by clicking on the arrow on the field description.  

 
4. On the pop-up menu, click the “Value Field Settings…” option, which is at the bottom of the menu. 
5. Select “Sum” from the “Summarize value field by” options in the pop-up window. Click OK. 
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Once complete, the PivotTable will update to show the cumulative “Estimated Solar PV Capacity.” With 
the “Solar PV: Utility scale” filter applied, this represents the estimated capacity only at sites that met 
the associated screening criteria. 

 
Exercise 6: How to add details within a PivotTable 
From the summary level, having the ability to view more specific data is often helpful to gain a better 
understanding of the main drivers in the data. In this example, you will now add two layers below the EPA 
Region: (i) State; (ii) Site Name. 

1. Select “ST” from the field list. Drag and drop it into “Row Labels” in the bottom right corner of the 
PivotTable Field List below “EPA Region.” 
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Once complete, the PivotTable will display the data by EPA Region, then by State. 
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2. To add the site level information, select “Site Name” from the field list. Drag and drop it into “Row 
Labels” in the bottom right corner of the PivotTable Field List below “EPA Region” and “ST.” 
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Once complete, the PivotTable will now show each Site Name below the EPA Region and State. For 
illustration purposes, only a subset of results for Region 6 in New Mexico are shown, while results for 
other regions can be viewed using by clicking on the “+” mark to expand the information in the table 
under each EPA Region.  
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RE-Powering America’s Land Initiative: Additional Tools & Resources 

RE-Powering Mapper 
The spreadsheet discussed in this reference guide is one component of the RE-Powering Mapper tool. The 
components and associated documentation include: 

- RE-Powering Mapper  
o RE-Powering Mapper: Google Earth overlay with RE-Powering Screened Sites 
o RE-Powering Screening Dataset 
o Data Documentation for Mapping and Screening Criteria for Renewable Energy Generation 

Potential on EPA and State Tracked Sites 
o RE-Powering Screening Results: National Maps by Technology 
o Fact Sheets 

 RE-Powering Mapper 
 RE-Powering Solar Technologies 
 RE-Powering Wind Technologies 
 RE-Powering Biomass Technologies 
 RE-Powering Geothermal Technologies 

Other Site Screening & Feasibility Assessment Tools 
- Site Screening  

o RE-Powering Solar Decision Tree 
o RE-Powering Wind Decision Tree  

- EPA-NREL Feasibility Studies 

Disclaimer: The RE-Powering Mapper and associated documents are provided solely as general information on screening potentially or 
formerly contaminated lands, landfills, and mine sites for renewable energy potential. It does not address all information, factors, or 
considerations that may be relevant in a particular situation. Results do not reflect an endorsement or recommendation for development 
potential by EPA. References to third-party publications, websites, commercial products, process, or services by trade name, 
trademark, manufacturer, or otherwise, are for informational purposes only. No endorsement or recommendation should be inferred 
and is not implied. EPA, NREL and the United States Government do not endorse any non-federal product, service or enterprise. 

http://www.epa.gov/renewableenergyland/rd_mapping_tool.htm
http://www.epa.gov/renewableenergyland/rd_mapping_tool.htm
http://www.epa.gov/renewableenergyland/maps/REPowering_Screening_Dataset.xlsx
http://www.epa.gov/renewableenergyland/docs/repowering_mapper_datadocumentation.pdf
http://www.epa.gov/renewableenergyland/docs/repowering_mapper_datadocumentation.pdf
http://www.epa.gov/renewableenergyland/maps/pdfs/
http://www.epa.gov/renewableenergyland/docs/repowering_mapper_factsheet.pdf
http://www.epa.gov/renewableenergyland/docs/repower_technologies_solar.pdf
http://www.epa.gov/renewableenergyland/docs/repower_technologies_wind.pdf
http://www.epa.gov/renewableenergyland/docs/repower_technologies_biomass.pdf
http://www.epa.gov/renewableenergyland/docs/repower_technologies_geothermal.pdf
http://www.epa.gov/renewableenergyland/docs/solar_decision_tree.pdf
http://www.epa.gov/renewableenergyland/docs/wind_decision_tree.pdf
http://www.epa.gov/renewableenergyland/rd_studies.htm
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